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CBSE | DEPARTMENT OF SKILL EDUCATION 
Information Technology (SUBJECT CODE - 402) 

 Blue-print for Sample Question Paper for Class X (Session 2025-2026)  

 
Max. Time: 2 Hours Max. Marks: 50 

PART A - EMPLOYABILITY SKILLS (10 MARKS): 

 
UNIT 
NO. 

 

 
NAME OF THE UNIT 

OBJECTIVE TYPE 
QUESTIONS 

SHORT ANSWER 
TYPE QUESTIONS  

TOTAL 
QUESTIONS 

1 MARK EACH 2 MARKS EACH 

1 Communication Skills - II 1 1 2 

2 Self-Management Skills - II 2 1 3 

3 ICT Skills - II 1 1 2 

4 Entrepreneurial Skills - II 1 1 2 

5 Green Skills - II 1 1 2 

TOTAL QUESTIONS 6 5 11 

NO. OF QUESTIONS TO BE ANSWERED Any 4 Any 3 07 

TOTAL MARKS 1 x 4 = 4 2 x 3 = 6 10 MARKS 

PART B - SUBJECT SPECIFIC SKILLS (40 MARKS): 
 

 
UNIT 
NO. 

 

 
NAME OF THE UNIT 

OBJECTIVE 
TYPE 

QUESTIONS 

SHORT 
ANSWER TYPE 

QUESTIONS 

DESCRIPTIVE/ 
LONG ANS. TYPE 

QUESTIONS 

 

 
TOTAL 

QUESTIONS 

1 MARK EACH 2 MARKS EACH 4 MARKS EACH 

1 
Digital Documentation 
(Advanced) 6  1 1  8 

2 
Electronic Spreadsheet 
(Advanced) 6  2 1  9 

3 
Database Management 
System 6  1 2 9 

 
4 

Maintain Health, Safety 
and Secure Working 
Environment 

 
6 

 
2 

 
1 

 
9 

TOTAL QUESTIONS 24 6 5 35 

NO. OF QUESTIONS TO 
BE ANSWERED 20 Any 4 Any 3 27 

TOTAL MARKS 1 x 20 = 20 2 x 4 = 8 4 x 3 = 12 40 MARKS 
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CBSE | DEPARTMENT OF SKILL EDUCATION 
Information Technology (SUBJECT CODE - 402) 

 Blue-print for Sample Question Paper for Class X (Session 2025-2026)  

 
Max. Time: 2 Hours Max. Marks: 50 

General Instructions: 
 

1. Please read the instructions carefully. 

2. This Question Paper consists of 21 questions in two sections: Section A & Section B. 

3. Section A has Objective type questions whereas Section B contains Subjective type questions. 
 

4. Out of the given (5 + 16 =) 21 questions, a candidate has to answer (5 + 10 =) 15 questions in the 

allotted (maximum) time of 2 hours. 

5. All questions of a particular section must be attempted in the correct order. 

6. SECTION A - OBJECTIVE TYPE QUESTIONS (24 MARKS): 

i. This section has 05 questions. 
 

ii. Marks allotted are mentioned against each question/part. 
 

iii. There is no negative marking. 
 

iv. Do as per the instructions given. 

7. SECTION B – SUBJECTIVE TYPE QUESTIONS (26 MARKS): 

i. This section has 16 questions. 
 

ii. A candidate has to do 10 questions. 

iii. Do as per the instructions given. 
 

iv. Marks allotted are mentioned against each question/part. 
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SECTION A: OBJECTIVE TYPE QUESTIONS 
 

Q. 1 Answer any 4 out of the given 6 questions on Employability Skills (1 x 4 = 4 marks) 

i. Aisha moved from Egypt to Germany for work but finds it difficult to adjust 
because she is not familiar with German customs and workplace etiquette, which 
affects her interactions with colleagues. This situation illustrates a: 
a) Interpersonal barrier 
b) Cultural barrier 
c) Physical barrier 
d) Linguistic barrier 

1 

ii. Rohan has been working long hours every day without a break. Over time, he 
starts experiencing headaches, anxiety, and fatigue. This is likely caused by 
prolonged: 
a) Stress 
b) Discipline 
c) Timeliness 
d) Goal – Setting 

1 

iii. When Ayaan switches on his computer, a particular software starts running 
automatically and manages all the hardware and other software. Which software 
is this? 
a) Web Browsers 
b) Designing Software 
c) Office Software 
d) Operating System  

1 

iv. An entrepreneur must be ready to take a ___________ and remain open to new 
ideas to grow their business. 
a) Satisfying human need 
b) Product and Service 
c) Calculated Risk 
d) Regular Production 

1 

v. The Sustainable Development Goals (SDGs) aim to tackle key challenges faced 
by businesses, governments, and society, such as: 
a) Gender Equality 
b) Energy & Climate Change 
c) Biodiversity 
d) All of the above 

1 

vi. The SMART method helps in setting effective goals for career and personal 
growth. In this method, what does the ‘A’ stand for? 
a) Abrupt 
b) Accountable 
c) Achievable 
d) Admirable 

1 

 

Q. 2 Answer any 5 out of the given 6 questions (1 x 5 = 5 marks)   

i. Ria has a long document where she needs to apply the same paragraph style at 
multiple scattered locations. She wants to avoid the repetitive task of selecting each 
word/paragraph and applying the style separately. Which feature should she use, 
and how can she stop using it once she is done? 
a) Use Fill Format option; stop it by clicking Fill Format button again or pressing Esc 
b) Use AutoFormat; stop it by closing the document 
c) Use Format Painter; stop it by pressing Ctrl+Shift+F 
d) Use Style Inspector; stop it by clicking on Close 

1 

ii. Arjun wants to slightly change the formatting of a predefined paragraph style in his 
Writer document. He does not want to create a new style, but rather update the 
existing one so that the changes apply wherever that style is used. Which option 
should he choose after formatting the text? 
a) Create New Style 
b) Update Selected Style 
c) AutoFormat 
d) Fill Format 

1 



402 – Information Technology – Class X Page 4 of 8   

iii. Meena has prepared a project report with multiple headings and sub-headings. She 
wants to create a section at the beginning of the report that lists all topics in order 
and allows her to jump directly to any section by clicking on it. Which feature of 
Writer should she use? 
a) Index of Keywords 
b) Hyperlink Tool 
c) Table of Contents 
d) Bookmark 

1 

iv. Assertion (A): In LibreOffice Calc, a Macro can be created as a function to perform 
repetitive calculations for which no predefined function exists. 
Reason (R): A function macro is written between Function and End Function 
statements, can accept arguments, perform operations, and return results. 
a) Both A and R are true, and R is the correct explanation of A 
b) Both A and R are true, but R is NOT the correct explanation of A 
c) A is true, but R is false 
d) A is false, but R is true 

1 

v. A teacher wants to prepare a summary report in LibreOffice Calc by calculating the 
average marks of students from two different spreadsheet files: X-A.ods and X-
B.ods. Which feature of Calc will help her achieve this? 
a) Data Consolidate 
b) External References to other documents 
c) What-if Scenarios 
d) Goal Seek 

1 

vi. Which menu path in LibreOffice Calc is used to accept or reject changes made in 
a shared spreadsheet? 
a) Tools > Review Changes > Manage 
b) File > Options > Track Changes 
c) Edit > Track Changes > Manage 
d) View > Track Changes > Review 

1 

 

Q. 3 Answer any 5 out of the given 6 questions (1 x 5 = 5 marks)              

i. Rahul wants to generate a Table of Contents (ToC) in his LibreOffice Writer 
document. However, when he inserts the ToC, it appears empty. Which of the 
following is the MOST likely reason for this issue? 
a) He did not protect the ToC against manual changes 
b) He forgot to apply heading styles (Heading 1, Heading 2, etc.) to his document 
headings 
c) He placed the cursor at the wrong location before inserting ToC 
d) He did not rename the default title "Table of Contents" to "Contents" 

1 

ii. During an audit, it is observed that employees are sitting for long hours with poor 
posture, and the computer screens cause glare. Which hazards are most relevant 
here? 
a) Physical and Fire Hazards 
b) Ergonomic and Health Hazards 
c) Chemical and Safety Hazards 
d) Biological and Health Hazards 

1 

iii. In a database table, if more than one field is used together to uniquely identify a 
record, it is called: 
a) Primary Key 
b) Foreign Key 
c) Composite Key 
d) Candidate Key 

1 

iv. If a database field is defined as VARCHAR(50) and the user enters 20 characters, 
how much storage is allocated? 
a) 50 bytes 
b) 20 bytes 
c) 64,000 bytes 
d) 255 bytes 

1 

v. A database designer wants to create a system where multiple tables are 
connected, allowing retrieval of related data from these tables efficiently. 
Which data model should the designer use? 
a) Relational Data Model 
b) Network Data Model 

1 
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c) Hierarchical Data Model 
d) All of these 

vi. The Query Design Window in LibreOffice Base is divided into how many 
parts? 
a) One 
b) Two 
c) Three 
d) Four 

1 

 

Q. 4 Answer any 5 out of the given 6 questions (1 x 5 = 5 marks) 

i. Which keyboard shortcut is used to open the Templates dialog box in LibreOffice 
Writer to manage or set default templates? 
a) Ctrl + Shift + T 
b) Ctrl + Alt + N 
c) Ctrl + Shift + N 
d) Ctrl + N 

1 

ii. Rohit is analyzing sales data spread across four different sheets in LibreOffice Calc. 
He wants to combine the data into a single sheet to identify overall trends and 
relationships. He also wants any change in the source sheets to automatically 
update in the consolidated sheet. Which feature and option should he use? 
a) Use Pivot Table with the "AutoFilter" option 
b) Use Consolidate with the "Link to source data" option enabled 
c) Use Data Validation with "Cell Range" enabled 
d) Use Scenario Manager with "Copy Results To" option 

1 

iii. Which of the following statements about forms in a database is incorrect? 
a) A form provides a user-friendly interface for entering and modifying data. 
b) Each field control in a form consists of a label and a field value text box. 
c) Forms can include graphics, titles, and additional text for better presentation. 
d) Forms are used to permanently store data like tables. 

1 

iv. During office work, employees complain of stress due to long hours and conflicts 
with colleagues. Which approach is most effective in reducing this hazard? 
a) Conflict resolution training and promoting hobbies 
b) Only installing ergonomic chairs 
c) Providing fire extinguishers 
d) Routine electrical inspections 

1 

v. Ritika has created a spreadsheet to calculate the EMI for a car loan. The EMI 
depends on the loan amount, interest rate, and loan duration (years). She fixes the 
loan amount and interest rate, but wants the EMI to be exactly ₹12,000 per month. 
Which feature of Calc should she use, and why? 
a) Goal Seek – because it adjusts the input (loan duration) to reach the exact target 
output (EMI = ₹12,000). 
b) Scenario Manager – because it allows creating multiple possible outcomes with 
different sets of inputs. 
c) Consolidate – because it combines data from different sheets into one summary. 
d) Data Validation – because it restricts the type of values that can be entered into a 
cell. 

1 

vi. Materials in a workplace are classified by risk to prevent fires. Which of the following 
correctly matches the material class with its description? 
a) Class A – liquids, grease, and gas; Class B – wood, cloth, paper 
b) Class C – electrical materials; Class D – volatile metals like magnesium and 
sodium 
c) Class B – electrical equipment; Class C – paper and cloth 
d) Class D – liquids and gas; Class A – electrical materials 

1 

 

Q. 5 Answer any 5 out of the given 6 questions (1 x 5 = 5 marks)  

i. Sneha is preparing 10 different project reports for her company. Each report 
requires the same header with the company logo, a footer with the legal notice, and 
predefined formatting for headings and text. Instead of manually inserting and 
formatting these elements in each report, which feature of LibreOffice Writer should 
she use? 
a) Styles 

1 
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b) Macros 
c) Templates 
d) Table of Contents 

ii. Which of the following components open along with the Report Wizard in 
LibreOffice Base? 
a) Report Builder 
b) Add Fields dialog box 
c) Both a and b 
d) Neither a nor b 

1 

iii. Rohini works as a floor manager. She has been assigned the task of conducting 
regular ________ to ensure the safety of life in case of any disaster or emergency 
by evacuating the place of danger. 
a) Cultural assembly 
b) Open house events 
c) Evacuation drill 
d) Trips and excursions 

1 

iv. Ramesh notices that a colleague has slipped and sustained a serious injury at work. 
Which sequence of actions demonstrates the correct approach to handling the 
accident according to safety protocols? 
a) Attend to injured person → inform supervisor → assist supervisor 
b) Report to supervisor → attend to injured person → assist supervisor 
c) Assist supervisor → attend to injured person → inform supervisor 
d) Ignore minor injury → continue work → report at the end of the day 

1 

v. Sonia works in a busy office where spills, broken glass, and clutter are common. To 
maintain a safe and productive workplace, which combination of actions should she 
prioritize? 
a) Clean her own workstation, report faulty lights, leave spills for cleaning staff 
b) Clean her workstation, clear spaces around machines, immediately clean spills, 
report faulty lighting 
c) Focus only on her own desk, ignore common areas, and wait for maintenance to 
fix lighting 
d) Only clean common areas and ignore her personal workspace 

1 

vi. A company’s finance team is preparing the quarterly budget report. Two 
managers, Mr. Raj and Ms. Meera, work on the same spreadsheet file separately 
(Budget_Raj.ods and Budget_Meera.ods). 
Now, before submitting the final report to the CEO, the team needs to: 

1. Check the differences in both versions. 
2. Merge the approved changes into one final file. 

As the data entry operator, which steps will you follow in LibreOffice Calc? 
a) Directly open Budget_Raj.ods and overwrite it with Budget_Meera.ods. 
b) Open Budget_Raj.ods, use Compare Document to review differences, then use 
Merge Document to finalize. 
c) Open Budget_Meera.ods and delete conflicting data manually. 
d) Use only Merge Document, since it automatically compares files too. 

1 
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SECTION B: SUBJECTIVE TYPE QUESTIONS 

Answer any 3 out of the given 5 questions on Employability Skills (2 x 3 = 6 marks) 
Answer each question in 20 – 30 words. 

Q. 6 Explain any two C’s of effective communication. 2 
Q. 7 Maya often gets frustrated at work and reacts impulsively in stressful 

situations. She wants to improve her ability to handle emotions and respond 
calmly. Which steps can help her manage emotional intelligence effectively? 

2 

Q. 8 Compare Self-Employment and Wage Employment. 2 

Q. 9 What are the major problems related to sustainable development concerning 
food and water? 

2 

Q. 10 Sara is worried about her personal and work data being stolen or infected by 
viruses. What steps can she take to protect her data effectively? 

2 

 
Answer any 4 out of the given 6 questions in 20 – 30 words each (2 x 4 = 8 marks) 

Q. 11 Aarav is learning to format documents in LibreOffice Writer. His teacher asked 
him to explain any two style categories along with one feature of each. What 
should Aarav write? 

2 

Q. 12 (a) What must you do before enabling the Record Changes feature? 
(b) How can you confirm that sharing has been disabled in the spreadsheet? 

2 

Q. 13 Differentiate between One-to-Many and Many-to-Many relationships in a 
database. 

2 

Q. 14 What are the common causes of electrical hazards at the workplace? 
Suggest one safety measure to prevent them. 

2 

Q. 15 What is a Macro? List any two real life situations where they can be used. 2 

Q. 16 While inspecting a machine, Rohan notices a colleague stuck to a live wire. 
What steps should Rohan follow to safely rescue the victim? 

2 

 
Answer any 3 out of the given 5 questions in 50– 80 words each (4 x 3 = 12 marks) 

Q. 17  Case Study 
A publishing company is designing an e-magazine in LibreOffice Writer. The 
editor wants to insert images of articles and advertisements in such a way 
that the layout looks attractive and professional. While working, the team 
faces some challenges: 

 In one article, two images overlap, and only part of the required picture 
is visible. 

 For the cover page, the editor wants the main image to stay fixed in the 
center, no matter how much text is added or removed. 

 In another section, the designer wants text to flow smoothly around the 
images so that the page looks balanced. 

 For an advertisement, the client requests that the product image should 
appear above all other elements. 

(a) Which feature should the team use to solve the problem of overlapping 
images? 
(b) Which setting will help the editor keep the main image fixed in the center 
of the cover page? 
(c) Which positioning option will make the text flow smoothly around the 
images in the article? 
(d) Which arrangement tool should be used to ensure the advertisement 
image appears above all other elements? 

4 
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Q. 18 Consider the table given below and answer the questions that follow: 

Student 
Name 

Roll 
Number 

Class Marks 

Aryan 
Sharma 

101 10A 450 

Priya Singh 102 10B 470 

Rohan 
Mehta 

103 10A 480 

Ananya 
Kapoor 

104 10C 460 

(a) Name all the fields in the given table. 
(b) Which field should be made the primary key? 
(c) Suggest a possible alternate key, if any. 
(d) Explain how a primary key differs from a foreign key with an example. 

 

4 

Q. 19 Musculoskeletal problems affect different parts of the body like neck, back, 
chest, arms, shoulders, and feet. These problems happen due to wrong 
posture or uncomfortable chairs while working on a computer. List four 
ways to avoid this problem. 

4 

Q. 20 Ruhi is managing a Sports Day database in LibreOffice Base. She has a 
master table called EventCategory and a transaction table called Events. 

(a) What is referential integrity? Give an example from Ruhi’s database. 

(b) Ruhi wants to stop deletion of any category that is being used in the 
Events table. Which option should she use? 

(c) If a CategoryID is changed in EventCategory, how does the Update 
Cascade option affect the Events table? Give an example. 

(d) If the Set NULL option is used and a master record is deleted, what 
happens in the Events table? How is it different from Set Default? 

4 

Q. 21 Arjun is preparing a project report in LibreOffice Calc that contains multiple 
spreadsheets. He wants smooth navigation between different sheets and also 
plans to include data from a government website. Initially, he uses an 
absolute hyperlink but later realizes it breaks when he shares the report with 
his teacher because the file path is different on another computer. His friend 
suggests trying a relative hyperlink instead. While inserting a hyperlink, Arjun 
notices the option Target in Document, which allows him to connect directly 
to a particular sheet. He also discovers the Link to External Data option to 
fetch live tables from a web page into his spreadsheet. 
 
(a) Why did the absolute hyperlink fail when Arjun shared the file, and how 
does a relative hyperlink solve this problem? 
(b) How does the Target in Document option increase the usefulness of 
hyperlinks in large spreadsheets? 
(c) Arjun wants to ensure that anyone viewing his report can update data 
directly from a government website. Which feature should he use, and why is it 
beneficial? 
(d) If Arjun wants to edit or remove a hyperlink later, what steps should he 
take? 

4 

 


